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INTRODUCTION
BASICS OF POSTER DESIGN:
A poster is a visual presentation of information, and in order for it to convey 
information effectively, it must be legible and attractive. The point of a poster is to 
communicate a message to an audience in a relatively short period of time (i.e., the 
time a viewer is willing spend standing in front of it to read it). The goal is to entice 
viewers to read your poster by making it attractive, and then to keep their attention 
with well-researched and well-written copy, presented clearly and coherently. 

Your poster should illustrate the main ideas and key points of your research, and 
be understood without further explanation or handouts. If you make viewers work 
too hard to understand your research, what’s to stop them from giving up and 
going on to something more compelling?
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STEP-BY-STEP:
At-a-glance checklist:

1. PLANNING

☐ size

☐ deadline

☐ schedule

☐ materials

☐ get help if you need it

2. ORGANIZING

☐ research

☐ write

☐ compile

☐ analyse

☐ simplify

☐ edit

☐ edit some more

3. GRAPHICS

☐ source 

☐ compile

☐ edit 

☐ arrange

☐ logo(s)

4. LAYOUT

☐ �design (orientation, columns, margins,  
alignment, arrangement)

☐ type (titles, text)

☐ colour

☐ hierarchy

☐ balance

5. PROOFING

☐ edit, edit, edit

☐ spelling, grammar, puncutation

6. PRINTING

☐ requistion

☐ create pdf

☐ send to printing services
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STEP-BY-STEP:

STEP 1: PLANNING
A little planning at the outset will save you a lot of time and 
energy in the end. With any project, you plan your time and 
strategy for organizing and creating content, but with a poster 
presentation, you have the added steps of designing it and 

getting it printed. There are two groups of things to consider 
when planning your poster: Technical Stuff and Content.

Technical stuff:

1. Get the facts. Before doing anything else, obtain technical specifications (such 
as size(s) and deadline(s)) and any other instructions from your instructor, preceptor 
or conference coordinator. 

2. Size. It may seem like the size of your poster is something you can work out at the 
end, just before you hit PRINT, but size is one of the first things you need to know, 
as it dictates a lot of other factors. For instance, if you have a maximum or minimum 
allowable size, that will determine the word count of your presentation (and vice 
versa), which will also determine the point size of your text, as well as the size and 
quantity of graphics. See WORD COUNT sidebar. DESIGN YOUR POSTER AT THE 
SIZE YOU WANT IT PRINTED.

You can re-size the poster as required, of course, but it’s a good idea to think about 
it now and test your copy in some sample layouts (at appropriate point sizes). Does 
your text run off the page? Do you have miles of empty space? You may have to 
adjust the size of your poster, or cut some of your copy. (Resist the urge to adjust 
the text size to fit your layout. Making text too small will affect legibility, and too 
big will look like you’re just trying to fill space). You can always adjust the layout 
size as you go, but if you approximate it from the start, you’ll save yourself the 
frustration of reformatting and/or rewriting halfway through. 

?
?

SOME QUESTIONS 
TO ASK:

• �What is expected from your 
presentation? 

• �Who is the audience?
• What is the objective?
• �Is there a maximum or minimum size 

requirement? 
• What is the deadline? 
• �Are there any formatting requirements?

SOME QUESTIONS 
TO ASK:

• �Where will it be posted, and on what 
kind of surface (a wall in a conference 
room, on a tri-fold display board)? 

• �Or will it be a digital projection? If 
so, what are the size and resolution 
requirements?

Find out the dimensions of the space 
you will be allotted, and size your poster 
appropriately. 
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3. Schedule. You’ll need to figure out how long it will take to complete each stage 
of your presentation, including printing time. Talk to the printer early on to get a 
printing time line and cost estimate. Make sure you give yourself enough time for 
printing. It’s a good idea to budget extra time, in case there are problems or errors.

• �For printing services, allow at least two days for printing — but check first, as this 
is not a guaranteed time line, and may vary depending on the time of year.

• �once you know your “to-print” deadline, use that date to create a work back 
schedule:

	

This schedule is just an example. You’ll have to figure out how much time you’ll 
need for each stage based on your own schedule, ability, and whether or not 
you’re beginning your research from scratch. The point is to make sure you give 
yourself enough time.

Example of work-back schedule:	 Printing: 3 days	 To print date: + 2 days for safety	 Final edits and proofing: 2 days	 Layout: 3 days	 Source, edit graphics: 2 days	 Create, organize, edit content: 3 days	 Planning: 1 day
Total time: 16 days (don’t forget to account for weekends)

In haste 
there is error. 

— Chinese proverb

tri-fold display
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—

—
—

—
>

PRINTING SIZES

Here are some general guidelines from 
MUN printing services:
• �Max printing height is 42” (3.5 ft. or 106 

cm) or if lamination is required, 36” (3 
ft. or 91 cm). Length is unlimited, but no 
more than about 72” (6 ft. or 183 cm) is 
recommended.

• �Larger posters can be printed, but they 
will be sent to a third party for printing, 
which can add time to the schedule.

• �For tri-fold displays, the dimensions are 
as follows: 



6Content:

If you’re starting from scratch, you’ll want to plan your research and writing. Give 
yourself as much time as you’d need to write a paper, but always keep in mind the 
restrictions and specifications for a poster. If you’ve already worked out a rough 
word count (see WORD COUNT sidebar), you’ll have a target. If you’re making a 
poster based on a research project or paper that you’ve already completed, you’ll 
need to plan how you’re going to convert that paper to a poster. ?SOME QUESTIONS 

TO ASK:

• �How will you edit/rewrite/rearrange  
your content to fit a poster format?

• �How will you organize it visually?
• �How will you illustrate your major 

findings?
• Who is your audience? 
• �How will you best capture THEIR 

attention? 
• �If viewers take only one thing from your 

presentation, what do you want it to be? 

Spend some time thinking about the 
answers to these questions, and keep 
them in mind as you put together your 
presentation. 

Ask tons of 
questions! The 
more planning and 
organizing you do

now, the more 
time you will save 

in the end. 


WORD COUNT:
Unfortunately, there’s no magic formula to determine how much copy 
to use, or how big to make your poster. Poster word counts can range 
anywhere from 500–2000 words, but this will depend on many factors, 
including how many images, charts or tables you plan to include, or the 
maximum/minimum size restriction. If you have a target size, you will have 
to tailor your word count and vice versa. In fact, word count is very liquid. 
Keeping in mind that the bigger the poster size, the bigger everything 
else must be (font, images), it often takes some trial and error to get it 
right. Here are some tips to help you figure it out:
• �Use columns, at least three and up to six (depending on width of poster).
• �Aim for approximately 15–20 words per line (this will be comfortable to 

read). If you have many more or fewer words per line, adjust the num-
ber of columns or the overall size to achieve this average.

• �Use at least 24 pt font, and up to 40 pt for the main text, depending on 
poster size. Adjust font size according to column width.

• �If you’re not sure, begin with the largest poster size you can use, and 
adjust your layout as required as you go. When you’re finished roughing 
in your content, you can change the page size to fit.
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STEP 2: ORGANIZING CONTENT
Posters are meant to convey a message quickly and efficiently 
— don’t just reproduce your paper in poster form.

• �Summarize information or research clearly and concisely; 
avoid long paragraphs — keep them short and use lists and 
bullets where possible.

• �It should be easily understood without extra notes or verbal explanation.
• �You may need to reorganize, rearrange or even cut material to create an effective 

poster. 
• Use graphs or charts to illustrate complicated data.
• Include all references and credits.
• �Organize content into sections (for example, introduction, abstract, method, 

results, discussion, conclusion, etc.).
• �Determine if any elements or ideas require extra emphasis, and decide how you 

will achieve it (bold type, boxes, colour, graphics? See EMPHASIS sidebar for tips).
• Edit, edit, edit. 

STEP 3: ORGANIZING GRAPHICS
1. Identify where graphics/photos/tables/charts are necessary 
or desirable to illustrate or emphasize a point, and how many. 

2. Source these graphics (see LINKS for stock photo resources) 
— or create them yourself: take photos (just be aware of resolution), 

draw something and scan it (hi-resolution, of course), create a pie-
chart, table or bar graph in Excel, PowerPoint or illustration software.

3. Confirm size and resolution (check with HSIMS if you’re not sure).

4. Edit. Are your graphics/images essential to your presentation? Do they enhance 
your research or make a point? If not, why include them?

If you can’t 
explain it simply, 

you don’t 
understand it 

well enough.
— Albert Einstein 

2

3


WORKING WITH  
IMAGES AND LOGOS

THE “RULES:”
• Every graphic should have a purpose.
• �Avoid unnecessary and distracting 

backgrounds, textures or decorations.
• �Complex images like charts, tables and 

graphs should be clearly legible. Take 
time to develop these kinds of graphics 
and make sure they’re large enough to 
be understood.

• �Make sure all images are high 
resolution (at least 300 dpi).

• �Do not artificially increase the size of 
an image (i.e., blow it up). This will 
degrade the print quality. If your image 
is not large enough, find or produce a 
larger one or omit it. (For help assessing 
image size and quality, contact HSIMS.) 
It is ok to decrease image size, BUT...

• �Be sure to resize graphics 
proportionally (don’t stretch or distort), 
particularly with logos or anything that 
contains type.
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5. Copyright/permissions. If you’re using graphics (photos, illustrations, charts, 
graphs) from another source (a book, article, the internet) make sure to obtain 
permission to use them, and pay any fees that may be required. Also be sure 
to include credits and attributions. And remember: just because something is 
on the internet, doesn’t mean it’s copyright free. And even if it is free, it doesn’t 
mean it belongs to you. Get permission and attribute sources properly! (See 
INTELLECTUAL PROPERTY sidebar)

6. Decide on rough placement of images in relation to your copy. Try to balance 
images with text. Note that once you’ve begun to lay out your poster, it may not 
be possible to place graphics exactly next to the relevant text. Place images where 
they fit best, and use reference tags in your text (e.g. See Table 1). 

Get permission and 
attibute sources 

properly!  
REMEMBER: just 

because something 
is on the internet, 
doesn’t mean it 
belongs to you. 


INTELLECTUAL PROPERTY
In an academic institution, plagiarism is a four-letter word. We all know that 
it’s wrong to misappropriate another person’s work, but in the internet age the 
boundaries of ownership can look a little blurry. Any work (whether it’s an idea, 
a piece of writing, research data, photography, artwork, etc) that you have not 
created yourself does not belong to you, and must therefore be used only with 
permission and be attributed to its source. You are likely well-versed in citing 
sources of published works, but don’t forget to attribute ALL work that has been 
produced or created by others. In the case of photography or artwork, you often 
need to get permission to reproduce and, in some cases, pay for the right to do 
so, even items downloaded from the internet. 

Copyright permissions are YOUR responsibility. MUN printing services will 
not print any materials without a signed copyright statement on the printing 
requisition.

MUN Policies:
Copyright policy: http://www.mun.ca/copyright/web.php
Plagiarism: http://www.med.mun.ca/Medicine/Policies---Guidelines.aspx

http://www.med.mun.ca/Medicine/Policies---Guidelines.aspx
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STEP 4: LAYOUT
Why design? We’ve already established that a poster is a VISUAL 

presentation of your ideas and research. You’ve spent a lot of 
time gathering and interpreting data, studying, researching 
and writing. Your hard work should speak for itself, right? Not 
always. If your poster is disorganized, messy and carelessly 
arranged, that is also how your work will be perceived (if it gets 

read at all!). Give your work a chance to speak by attracting and 
keeping reader attention with an organized, legible and attractive 

poster. Take care with the design, and your work will shine! 

How do I do that?

Go with the flow. Set up your layout with a natural visual progression: top to 
bottom, left to right

Less is more. A well-designed poster is not necessarily a fancy or complicated 
one. In fact, most design is improved by simplification. Good design is about 
clarity and communication, not flashy graphics or effects. 

Type. Posters should be legible from at least one metre away, and attract attention 
from five metres:
	 • for body text, 24 -32 pt; 
	 • for titles, 48-72 pt;
	 • �keep point sizes consistent (exceptions: varying levels of heads, sidebar 

materials, references). Ideas/sections that are equally important should be 
treated equally. Don’t shrink point size in one section to make it fit; 

	 • �choose a legible typeface, and mix fonts with caution (see FONT sidebar)

�Margins. Give your content some “breathing room” by including clear, consistent 
margins around your layout and in between columns and sections.

4 Design is thinking 
made visual. 

— Saul Bass

We are what 
we repeatedly do. 

Excellence, 
therefore, is not an 

act, but a habit.
 — Aristotle 
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�Columns. The eye gets lost if it has to travel too far. Make your poster easy to 
navigate by dividing the layout into columns.

Alignment. Flush left or justified text works best (avoid centred or right justified). 
Don’t mix alignments. Create an invisible grid to help you keep your layout 
organized. 

�Gestalt. Group like objects together. The mind naturally links elements that are 
physically close. Use this to your advantage by putting connected ideas next to 
each other. However, be aware that objects that are too close together create 
visual tension, which can be distracting.

Balance text and images. Give your viewer breaks, by interspersing graphics with 
blocks of text where possible.

Be consistent. Keep your style, typography, spacing and colour consistent for a 
strong, cohesive layout.

Visual hierarchy. Create one main focal point. It should be clear what to look at 
first, second, third… (Titles, sub-heads, main text, etc.)

Create emphasis sparingly. You want to draw attention to key ideas, but do so 
carefully, as too much emphasis begins to look like none. See EMPHASIS sidebar

If you make 
everything bold,

nothing is bold. 
— Art Webb
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STEP 5: PROOFING
You already edited your copy before you laid out your poster, 
but once you’ve put it all together, you’ll want to proofread 
it again and again. When importing or copying-and-pasting 
text into your layout, it’s possible to lose original formatting 

(e.g. italics or bullets) or to introduce errors, so proofreading 
is especially important at this stage. Double-check that your 

layout matches your copy. Also, now that you’re looking at it in a 
poster format, you might see typos and errors that you didn’t notice before, like 
extra spaces or missing punctuation.

Some proofreading tips:

• You can’t proofread too much.
• �Use spelling and grammar check, but don’t rely on it exclusively — make sure to 

proofread it yourself as well.
• �Double- and triple-check spelling — especially proper names, brand names and 

titles.
• �Get a friend or colleague to proofread.
• �Take some time away from your poster (an hour, a day) and proofread again with 

fresh eyes.
• �Pay attention to typography: word, line and column breaks/hyphenation; double 

spacing and punctuation errors — these things are distracting and detract from 
your message. 

• Trust your instincts: if it doesn’t look right to you, keep making adjustments.

5 Design is the 
application of intent 

— the opposite 
of happenstance, 

and an antidote to 
accident. 

— Robert L. Peters 
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STEP 6: PRINTING
Now we come to the final step: printing. There are three 
things to do before you can send your file to print:

1. Final file prep: You can send your final PowerPoint or 
Word file to the printer, but because of differences in operating 

systems, program versions and fonts, it’s possible that what’s 
printed won’t match what you sent. A best practice is to save your file as a pdf. This 
will ensure that nothing can be accidentally changed in your file. See HOW TO 
LAY OUT A POSTER IN POWERPOINT sidebar.

2. Printing requisition: Get a printing requisition form from printing services. 
You’ll need to get a finance code and signature from your department, instructor or 
supervisor. Your job cannot be printed without a completed form.

3. File to print: In general, it’s not advisable to e-mail files to the printer. Put 
finished file on a usb; bring the file and requisition to printing services (or contact 
printing services to make alternate arrangements). If you must e-mail files, make 
sure to follow up with printing services to confirm that your job was received and is 
in the queue. For contact information for printing services, see CONTACTS in the 
links & resources section.

6
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HOW-TOS AND SIDEBARS:
At-a-glance list

HOW TO DETERMINE WORD COUNT

HOW TO LAY OUT A POSTER IN POWERPOINT

HOW TO WORK WITH GRAPHICS AND LOGOS

INTELLECTUAL PROPERTY

HOW TO CHOOSE AND MIX TYPEFACES

HOW TO SELECT AND COMBINE COLOURS

HOW TO CREATE EMPHASIS
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HOW TO DETERMINE WORD COUNT
Unfortunately, there’s no magic formula to determine how much copy to use, 
or how big to make your poster. Poster word counts can range anywhere from 
500–2000 words, but this will depend on many factors, including how many 
images, charts or tables you plan to include, or the maximum/minimum size 
restriction. If you have a target size, you will have to tailor your word count and 
vice versa. In fact, word count is very liquid. Keeping in mind that the bigger 
the poster size, the bigger everything else must be (font, images), it often takes 
some trial and error to get it right. 

Here are some tips to help you figure it out:
• �Use columns, at least three and up to six (depending on width of poster).
• �Aim for approximately 15–20 words per line (this will be comfortable to 

read). If you have many more or fewer words per line, adjust the number 
of columns or the overall size to achieve this average.

• �Use at least 24 pt font, and up to 40 pt for the main text, depending on 
poster size. Adjust font size according to column width.

• �If you’re not sure, begin with the largest poster size you can use, and 
adjust your layout as required as you go. When you’re finished roughing 
in your content, you can change the page size to fit.
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HOW TO LAY OUT A POSTER IN POWERPOINT
1. Select a blank presentation.

2. �Click File > Page Setup and 
select Custom from the drop-
down menu under Slides 
sized for. Enter your desired 
dimensions in the Width and 
Height fields. Choose Landscape 
orientation.

3. �Select the text tool and create 
a text box for the main title and 
several text boxes for the content 
your poster (you can copy and 
paste from a Word document or 
different PowerPoint file, or type 
directly into the text boxes). Enter 
all text and make sure to leave 
room for any imagery, graphics 
tables and charts.

4. �Create tables, graphs and charts. 
These can be created directly in 
PowerPoint using the built-in tools, 
migrated from Word or Excel, or 
imported as image files.

5. �Add images and graphics. To add 
a photo or graphic, click Insert 
> Photo > Picture from File. A 
finder window will open, and you 
can select images from your hard 
drive or a disk. Once you place an 

image in your document, you can 
move it by dragging it around your 
layout, or by clicking on it and 
using the arrow keys. 

6. �Re-size, crop or otherwise format 
your image by clicking on the 
image in your layout, then click 
Format > Picture and choose from 
the formatting menu. (For more 
info about images and graphics, 
see WORKING WITH GRAPHICS/
LOGOS sidebar.)

7. �Once all the pieces are roughly 
in place, you will likely need 
to rearrange and re-size your 
elements to fit and create a 
pleasing arrangement. Make 
sure to leave sufficient and equal 
space between text boxes and 
columns and around images. Use 
a consistent alignment.

8. �When you are completely finished 
your poster and are ready to send 
it to the printer, a best practice 
is to save it as a pdf. PDF stands 
for Portable Document Format, 
and it’s a virtually unalterable 
file. Saving your poster as a PDF 
will ensure that nothing will be 
inadvertently changed when the 
file is opened by another user, 
and you can be sure that what 
you send to the printer is what 
you get back. 

	� Here’s how: Select File > Save 
As. In the Save As dialogue box, 
select PDF from the Format 
drop-down menu. Click Save. 
Simple as that!

TIP: use 
guides to help align 

boxes and other elements. 
Click on a guide, then hold 

the Ctrl key down while dragging 
the mouse to create a new guide. 

Use as many vertical and horizontal 
guides as you need to align and 

space the text and graphics. 
These guides are a reference 

tool and will not be visible 
when the poster is 

printed.
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HOW TO WORK WITH GRAPHICS AND LOGOS
THE “RULES:”
• Every graphic should have a purpose.
• �Avoid unnecessary and distracting backgrounds, textures 

or decorations.
• �Complex images like charts, tables and graphs should 

be clearly legible. Take time to develop these kinds 
of graphics and make sure they’re large enough to be 
understood.

• �Make sure all images are high resolution (at least 300 dpi).
• �Do not artificially increase the size of an image (i.e., blow it 

up). This will degrade the print quality. If your image is not 
large enough, find or produce a larger one or omit it. (For 
help assessing image size and quality, contact HSIMS.) It is 
ok to decrease image size, BUT

• �Be sure to re-size graphics proportionally (don’t stretch or 
distort), particularly with logos or anything that contains type.

WHAT IS RESOLUTION?
Any image that will be used in print, must be high resolution 
— at least 300 dpi. DPI stands for “dots per inch,” meaning 
the amount of information contained in the image. If you’ve 
ever tried to print an image that you’ve downloaded from the 

internet you’ve probably noticed that the printed image looks 
a bit different from what you saw on screen. That’s because 
most photos on the internet have very small pixel dimensions 
(fewer dots). There are two reasons for this: a smaller amount 
of data allows pages to load faster, and computer screens 
don’t require as many pixels or dots in order for images to 
look good. But in order for an image to look just as good in 
print, more information must be present, otherwise photos 
begin to look blurry, pixelated and dull. So it’s important to 
note that just because a photo looks sharp and clear on your 
screen, it won’t necessarily look that way in print.

HOW TO CHECK THE RESOLUTION AND SIZE 
OF YOUR IMAGES:
In general, images downloaded from the web will not be 
suitable for use on a poster. Most web images are about 
640 pixels wide by 480 pixels high, which translates to about 
2” by 1.5” in print — slightly larger than a postage stamp. 
Exceptions are images downloaded from stock photo sites, or 
if it is clearly indicated that a high resolution image is available 
for download. 

(cont’d, next page)
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If the provenance of your image is unknown or unclear, here’s 
how you can figure out the pixel ratio:
Right click on the file name, then select Properties > 
Details (on a Mac, click the file name and press Cmd-i) 
to see the file info. Look for Dimensions. Divide each 
measurement (height and width) by 300, and you will get an 
approximate size for print. 
Example:
Dimensions: 1200 x 1850
1200 ÷ 300 = 4
1850 ÷ 300 = 6.17

So, the largest size this image can be printed is about 4” x 6”.
If you can’t find the image dimensions, another way to 

approximate is by identifying the number of KB (kilobytes), 
MB (megabytes) or GB (gigabytes).

[1000 bytes = 1 KB 
1000 KB = 1 MB
1000 MB = 1 GB]

Again, view the file info and look for Size (a number, followed 
by either KB, MB or GB.  For print, the larger the size the 
better, but generally anything less than 300 KB will not be 
suitable, and at least 1 MB is preferable.

If you need help determining the size and resolution of your 
images, please contact us.

INTELLECTUAL PROPERTY
In an academic institution, plagiarism is a four-letter word. We all know that it’s wrong to misappropriate another person’s 
work, but in the internet age the boundaries of ownership can look a little blurry. Any work (whether it’s an idea, a piece of 
writing, research data, photography, artwork, etc.) that you have not created yourself does not belong to you, and must 
therefore be used only with permission and be attributed to its source. You are likely well-versed in citing sources of published 
works, but don’t forget to attribute ALL work that has been produced or created by others. In the case of photography or 
artwork, you often need to get permission to reproduce and, in some cases, pay for the right to do so, even items downloaded 
from the internet. 

Copyright permissions are YOUR responsibility. MUN printing services will not print any materials without a signed copyright 
statement on the printing requisition.

MUN Policies:
Copyright policy: www.mun.ca/copyright/web.php
Plagiarism: www.med.mun.ca/Medicine/Policies---Guidelines.aspx

http://www.med.mun.ca/Medicine/Policies---Guidelines.aspx
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HOW TO SELECT AND COMBINE TYPEFACES AND COLOURS
TYPEFACES
A common tendency is to use many different fonts to add interest or delineate 
different information, but in the interest of clarity and consistency, it is best to use 
just one or two typefaces. This will keep your poster looking uniform and easy to 
read. If you feel you need more variety in your typography, use the bold or italic 
versions of your chosen font(s), or try underlining, using all caps or changing the 
type size. For more ideas, see the EMPHASIS sidebar. It is perfectly acceptable 
to use a single typeface, but if you decide to use two, a best practice is to use one 
SERIF (ex: Times New Roman) font and one SANS SERIF (ex: Arial) font. Avoid the 
use of NOVELTY fonts (ex: Scriptina or Comic Sans), as they can be difficult to read 
and can look unprofessional. The main thing is to be consistent in the application 
of typefaces, ie. use one font for headings, and the other for body text. 

For more information about good typography, visit: www.thinkingwithtype.com/

COLOUR 
It is also best to keep to a colour scheme of one or two colours (not including  
photographs or illustrations). Too many colours for type and graphic elements can 
be distracting and confusing. The best colour combination for posters is one with 
high contrast (ex: black and white). It is best to use black or dark type on a white 
or light background, but if you decide to do the opposite (white or light type on 
a black or dark background) it is a good idea to increase the size of the type, to 
make sure it is still easily legible.

SANS SERIF TYPEFACES

Arial	 Corbel

Gill Sans	 Helvetica

Myriad	 News Gothic

Verdana

SERIF TYPEFACES

Times New Roman

Georgia

Garamond

Cambria

Palatino

Century Schoolbook

Bookman Old Style

NOVELTY TYPEFACES  
(use with caution!)

Brush Script	 Comic Sans
Giddyup	 Mistral
Papyrus	 Scriptina

Lucida  Handwriting

TYPE STYLES

There are now about as many 
different varieties of letters as 
there are different kinds of fools.

 — Eric Gill
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CREATING EMPHASIS
There are many ways to emphasize or set off key ideas — from bold or coloured text to underlines, to boxes and graphics. But 
be wary of using too many different techniques in a single piece, as it will end up looking cluttered and confused, and your 
emphasis will get lost. Choose one or two methods, and be consistent throughout your layout.

Here are some ideas:

TYPOGRAPHICAL METHODS

• ALL CAPS

• italics (use for emphasis within a 
paragraph)

• bold type

• larger point size
• underlining

• coloured type

Note: with type, it’s ok to combine 
several elements into one method of 
emphasis, for example, use 

ALL CAPS, BOLD, A 
LARGE POINT SIZE AND A 
DIFFERENT COLOUR. 

GRAPHIC METHODS

• icons/symbols 

• charts/tables/graphs

• boxes

• rules (lines)

• pictures/illustrations

Just be sure that you use this same 
method for each item that requires 
equal empahsis (ie, the same point 
size and colour for all headings).

Food security refers to access to healthy food for all people. Access 

to healthy food can mean both availability and affordability of 

healthy foods. 

WHAT DOES IT MEAN TO BE FOOD SECURE?

Being food secure means1:

•	 	Being	able	to	get	and	afford	the	food	you	need.

•	 Being	able	to	eat	safe	and	healthy	food.

•	 Being	able	to	get	the	foods	you	like	and	want	to	eat.

•	 	Protecting	the	water,	land,	air,	and	people	who	grow	and	

produce	our	food.

WHAT DOES IT MEAN TO BE FOOD INSECURE?

Being food insecure means:

•	 	Not	being	able	to	get	enough	healthy	foods	that	you	like	and	

enjoy.

•	 	Worrying	about	where	your	next	meal	will	come	from.

•	 	Worrying	about	the	safety	of	your	food	and	about	what	is	in	it.

FAST FACTS ON FOOD SECURITY/ INSECURITY IN 

NEWFOUNDLAND AND LABRADOR

Fast Fact 1:	Results	from	the	2007	-	2008	Canadian	Community	

Health	Survey	(CCHS)	show	that	approximately	9.6% of 

households	in	Newfoundland	and	Labrador	are	food	insecure,	

compared	to	the	national	level	of	7.7%.

Fast Fact 2:	Adverse	weather	conditions	in	rural	coastal	communities	

in	Labrador	make	regular	road	and	marine	transportation	practically	

non-existent	in	winter	months.	This	can	impact	the	delivery	and	access	

to	food	for	local	residents	of	that	region.

Fast Fact 3:	Food	banks	are	one	of	the	main	responses	to	food	

insecurity	in	Canada.	

The	graph	below	shows	that	in	2010	

Newfoundland	and	Labrador	had	a	

higher	percentage	of	food	bank	

users	than	any	other	province	in	

the	country!2

Remember:	food	banks	are	

only	an	emergency	solution	to	

the	problem	of	food	security,	and	

they	should	not	be	relied	on	as	the	

solution.

Fast Fact 4:	In	2006,	the	provincial	cost	of	

unhealthy	eating	was	estimated	to	be	

approximately	$126	million	annually	(based	on	

estimates	of	national	projections3).	People	who	are	food	

insecure	are	more	likely	to	eat	cheaper,	less	healthy	food.

Fast Fact 5: Currently,	the	province	only	produces	about	10	–	

15%	of	our	fresh	fruit	and	vegetable	needs.	Outside	of	harvest	

season	it	is	estimated	that	we	only	have	about	a	2-3	day	supply	of	

perishable	foods	in	province4.

WHAT SIMPLE THINGS CAN YOU DO?

Grow your own food	in	a	square	foot	garden	or	in	your	

backyard.

Join a community garden if	you	

have	no	access	to	land.	Community	

gardens	provide	an	excellent	

opportunity	to	make	new	friends	

and	learn	from	more	experienced	

gardeners.

Start cooking!	Cook	at	least	one	

meal	a	week	at	home	as	a	family.	This	

can	be	a	great	opportunity	for	children	

to	learn	some	basic	cooking	skills	and	an	

excellent	opportunity	to	pass	on	those	

great	family	recipes!	

Start talking	about	where	your	food	comes	

from	with	your	children,	family,	and	friends.

 Buy more local fresh foods.	Pick	up	a	Buy	Local,	Buy	

Fresh	map	for	the	Avalon	region!	Maps	can	be	found	at	

various	locations	including:

	 	 		 	 •	 	Rocket	Bakery	and	Fresh	Food,	272	Water	

Street,	St.	John’s	http://rocketfood.ca

	 	 	 	 •	 	Lester’s	Farm	Chalet,	92	Pearltown	Rd.,	St.	

John’s,	www.lesterfarms.ca

	 	 	 	 •	 	Memorial	University	of	Newfoundland	

Botanical	Garden,	306	Mt.	Scio	Road,	St.	

John’s	www.mun.ca/botgarden

•	 	Become	a	member	of	the	Food	Security	Network	of	

Newfoundland and Labrador.	As	a	member,	you	will	be	able	

to	receive	monthly	updates	on	news,	events,	and	resources	

related	to	food	security.	It	will	also	give	you	an	opportunity	to	be	

a	part	of	the	united	voice	on	food	security	issues	in	this	province.	

WHERE CAN YOU FIND MORE INFORMATION?

•	 	The	Food	Security	Network	of	Newfoundland	and	Labrador.	

Visit	their	website	at	http://www.foodsecuritynews.com

•	 	Food	Education	Action,	St.	John’s	(FEASt).	Visit	their	website	 

at http://www.feastnl.ca

•	 	Social	Determinants	of	Health:	The	Canadian	Facts.	Visit	 

the	website	http://www.thecanadianfacts.org

•	 	Thought	about	Food:	A	workbook	on	Food	Security	 

and	Influencing	Policy.	Visit	their	website	at	 

http://www.foodthoughtful.ca

REFERENCES:

1	 	Food	Security	Projects	of	the	Nova	Scotia	Nutrition	Council	and	the	Atlantic	Health	Promotion	
Research	Centre,	Dalhousie	University.	(June	2005).	Thought	about	food?	A	workbook	on	food	
security	&	influencing	policy.	In	Foodthoughtful.	Retrieved	from	http://www.foodthoughtful.ca

2	 	Food	Banks	Canada.	(2010).	Hunger	Count	2010:	A	comprehensive	report	on	hunger	and	food	
bank	use	in	Canada,	and	recommendations	for	change.	Retrieved	from	http://www.
foodbankscanada.ca/FoodBanks/MediaLibrary/research/hunger-count-2010.pdf

3	 	Newfoundland	and	Labrador.	(2006).	Eating	healthier	in	Newfoundland	and	Labrador:	Provincial	
food	and	nutrition	framework	and	action	plan	(phase	1:	2005-2008).	[St.	John’s,	N.L.]:	Government	
of	Newfoundland	and	Labrador.	

4  Food	Security	Network	of	Newfoundland	and	Labrador.	(2010).	Presentation	to	the	Minister	of	
Finance	and	President	of	Treasury	Board	Honorable	Tomas	M.	Marshall:	Pre-budget	
Consultation	Submission.	In	Food	Security	Network	of	Newfoundland	and	Labrador.	Retrieved	
from	http://www.foodsecuritynews.com/PreBudgetConsultation_2010_FSN.pdf

Healthy Food For All
(Food Security)

Faculty of Medicine

All provinces saw food bank use as a percentage of populaton increase 
in 2010. Newfoundland (6%) has the highest percentage served, 
followed by Manitoba (4.7%) and Ontario (3.1%).
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LINKS/ONLINE RESOURCES
DOCUMENTS:
Copyright policy: www.mun.ca/copyright/web.php

Graphic standards: www.mun.ca/marcomm/image/graphic/

Plagiarism: www.med.mun.ca/Medicine/Policies---Guidelines.aspx

MUN Writing centre resources: www.mun.ca/writingcentre/resources/

MUN Style Guide: www.mun.ca/marcomm/style/

PLACES:
Printing services: www.mun.ca/printingservices/

HSIMS: www.med.mun.ca/hsims/home.aspx 

LOGOS:
Image services: http://www.mun.ca/marcomm/image/logo.php

STOCK PHOTOS:
MUN photo gallery: www.mun.ca/marcomm/image/photogallery.php

Morgue File: www.morguefile.com/

Wikimedia Commons: http://commons.wikimedia.org/wiki/Main_Page

Flickr Creative Commons: www.flickr.com/creativecommons/

Image*After: www.imageafter.com/

Search by Creative Commons: search.creativecommons.org/

http://www.mun.ca/marcomm/image/graphic/
http://www.med.mun.ca/Medicine/Policies---Guidelines.aspx
http://www.mun.ca/writingcentre/resources/
http://www.mun.ca/marcomm/style/
http://www.mun.ca/marcomm/image/photogallery.php
http://www.morguefile.com/
http://commons.wikimedia.org/wiki/Main_Page
http://www.flickr.com/creativecommons/
http://www.imageafter.com/
http://search.creativecommons.org/
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CONTACTS:

General Information

HSIMS - Health Sciences Centre, rm 1614 (across from HSC library)

Printing Services

Tel: 864 4056 

www.mun.ca/printingservices/

Ingstad Building, Elizabeth Ave

Faculty of Medicine Communications

communications.office@med.mun.ca 

REFERENCES:

www2.napier.ac.uk/gus/writing_presenting/academic_posters.html

http://clt.lse.ac.uk/workshops-and-courses/Course-resources/Poster-Design-Tips.php

www.wpi.edu/Academics/ATC/Media/poster-design.html

http://www2.napier.ac.uk/gus/writing_presenting/academic_posters.html
http://clt.lse.ac.uk/workshops-and-courses/Course-resources/Poster-Design-Tips.php
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